
Welcome
TweakAll is a small program that allows you to take control over your Windows operating system.

Does your Windows 95/98 system take too long to startup? Not a problem! With TweakAll you can cut 
boot times and give yourself some more free memory at the same time.

Don't like the way Windows 2000 hides items on your Start Menu? Then stop Windows from doing that!

Always running out of memory after running a few applications? With TweakAll you can reclaim wasted 
memory from the operating system.

Using a series of powerful plugins, TweakAll 2.1 is more powerful than ever and completely expandible. It 
has too many options to be listed here, go to the plugins page to see how much TweakAll can do.

And best of all, it's completely FREE! No adverts, no nags, no time limits and no 'pro' versions you have 
to pay for.



Contact Details
For the most up to date information regarding Codeforge products and services, please visit our web site 
at http://www.codeforge.co.uk

To e-mail us, please use one of the addresses below.

For general enquiries : support@codeforge.co.uk



Overview
The first time you run TweakAll 2 you will be presented with an almost empty screen.    The first thing you 
need to do is to download and install some plugins.    For more information on TweakAll 2 plugins, click 
here.    For instructions on how to download and install plugins, click here.

Once you have a few plugins installed, then changing you windows settings is simply a matter of selecting
the options you want and then pressing the 'Apply' button.    No settings will be changed until you press 
the apply button, so if you change your mind just click 'Cancel'.

Help for the plugins is available, click here for more information.

Enjoy using TweakAll, and feel free to send us your comments, suggestions or requests - the contact 
details are here.



Downloading Updates
In most instances downloading updates and new plugins for TweakAll 2 is a very simple matter.    In 
TweakAll simply select the 'Check for Updates' option from the help menu.

You will then be presented with the screen shown below:

Make sure that you are connected to the internet and then press the 'Update' button.    TweakAll will then 
automatically connect to out web site, and display a list of updates that are available to you.



Updates that are available are split into three categories.    Engine updates are updates to the main 
TweakAll program.    If an update is available here it is recommended that you download it.    Plugins 
updates are new versions of plugins that you already have installed.    Finally, new plugins are plugins that
you do not currently have installed.    If you see a plugin that you are interested in, you can simply double 
click the name of the plugin and TweakAll will download and display some information about the plugin.

Once you have decided which plugins you require, check the plugins you require and press the 'OK' 
button and TweakAll will then automatically download and install your selected plugins.

Problems Downloading Updates

If the normal download method does not work for you, then you can use an alternate download method.    
From Web Update screen, press the Configure button.    From the screen that is shown, select the 'Use 
Alternate Download Method'.



To use this download method, you must have Internet Explorer 4 or above installed.    As this method uses
Internet Explorer, if you can access the internet and download files through Internet Explorer then this 
download method should work.    It is not set as the default, as not everyone has Internet Explorer 
installed.

If you are still having problems using this feature after selecting the alternate download method then the 
easiest way to download updates and new plugins is to visit our website at www.abtons-shed.com and 
download the updates directly from there.    For instructions on how to manually install plugins, click here.



What are plugins?
Plugins are small extensions to TweakAll.    The main application is simply a host for these applications, 
and when you run TweakAll for the first time after installing it you will be presented with an almost blank 
screen.    By downloading and installing plugins, you will then be able to tweak your Windows settings.

There are many plugins available to download for TweakAll, that give you the power to change many 
settings within Windows.    For example, there is a Windows 2000 plugin that allows you to stop Windows 
2000 from hiding items on the Start Menu if you do not use them for a certain period of time.

When a plugin is installed, a button will appear for it in the bar to the left of the TweakAll main screen.

TweakAll is smart enough to only display a button here for plugins that can be used in your Windows 
operating system, so you do not have to worry about breaking anything by trying to change a setting your 
version of Windows does not support.

The use of plugins gives TweakAll the power to be easily extended to support new versions of Windows, 
and also add new functions as we develop them.    We are sure that once you get used to using plugins in
TweakAll, you'll never go back to using old fashioned tweaking programs.



Getting help in plugins
To get help for each of the available options in the various TweakAll plugins, simply leave your mouse 
cursor over the option you require help for.    After about a second a window will pop-up detailing what the 
option changes, and in some cases a recommended setting.    

The pop-up window will automatically disappear after 10 seconds.

You can also get more detailed help by selecting the option 'Help for the current plugin' from the Help 
menu in TweakAll.

This will load and display the help file the plugin you are currently using in TweakAll.



Downloading and Installing plugins
There are two ways to download plugins for TweakAll 2.    The easiest route is to simply select the 'Check 
for Updates' option from the 'Help' menu in TweakAll 2.    For more information about using the 'Check for 
updates' feature, click here.

The second method to download plugins is to manually download the plugins from our web site.    Visit our
website at http://www.abtons-shed.com and go to the TweakAll page, and then to the plugins page.    
Download the plugins you require.    The web site contains full instructions for installing these plugins, 
which has been duplicated below for ease.

How to install TweakAll 2.0 Plugins manually.

There are two methods you can use to install TweakAll 2 plugins.

Method 1 - The Easy Way

Find the plugin you want to install in the Windows Explorer.    Double click the plugin file, and it will be 
installed automatically.

Method 2 - Use this method if the method above does not work correctly for you.

1. Download the plugins you require.
2. Run TweakAll 2.0
3. Select 'Install Plugin' from the 'File' menu.

4. You will now be presented with a standard Windows 'Open' dialog.

5. Select the plugin you want to install and click 'Open'. (You can only install one plugin at a time).



6. The plugin will now automatically be installed.



Removing Plugins
Removing plugins that you no longer need, or cannot be used on your version of Windows, is achieved 
very simply.

Select the option 'Remove Plugin' from the 'File' Menu.

You will then be presented with a screen listing all the plugins you currently have installed.

Plugins that can be used in your current version of Windows are listed under the 'Useable Plugins' 
heading, whereas plugins that cannot be used are listed in the 'Unuseable Plugins' section.

To remove a plugin simply select it, and then press the 'Remove' button.    You will then be asked to 
confirm you want to remove the selected plugin, by replying 'Yes' the plugin will be removed.

Please Note

Plugins are not removed when you uninstall TweakAll.    When uninstalling TweakAll either remove all the 
plugins as described above before uninstalling, or simply delete the TweakAll directory after you run the 
uninstall application.



Password Protection
If more than one person uses your computer, you may not want them to alter the settings you have made 
using TweakAll.    For this purpose TweakAll can now be password protected.

To enable password protection in TweakAll, go to the 'File' menu and then Select 'Password Settings'

You will then be presented with the screen shown below.

If you want to enable password protection, check the 'Enable Password Protection' box and enter the 
password you require in the boxes provided.    When you have done this press the 'OK' button.

To remove the password protection simply deselect the 'Enable Password Protection' box and press the 
'OK' button.

When password protection is enabled, whenever TweakAll 2 is run you will be presented with a login box, 
and TweakAll cannot be used unless you enter the correct password.

A word of warning

Please be careful not to forget your password!    If you enable password protection and then forget your 
password, you will not be able to get back into TweakAll even if you uninstall and then reinstall TweakAll.   
Use this function with caution!



Overview
TweakTray is a small, but useful, addition to TweakAll.    It is a seperate program that is installed alongside
TweakAll, and can be run by clicking on the icon from the Start Menu.

Once TweakTray is run, it will appear as a small icon in the System Tray (usually in the lower right hand 
corner of the screen, next to the clock).

Right clicking on the icon will bring up a menu of options that TweakTray can perform.

Please refer to the rest of this section in the help file for more information on the different options.



Configuration
The TweakTray configuration screen is accessed by selecting 'Configure' from the menu that appears 
after right-clicking on the TweakTray icon in the System Tray.

From the configuration screen you can configure several aspects of TweakTrays behaviour.

Run TweakTray when Windows Starts

Checking this option will make TweakTray automatically run when you log into Windows.    Deselecting 
this option will prevent this from happening.



Display Free Memory Options

By selecting this option, all the free memory options will be displayed on the TweakTrays right-click menu. 
If you never use these options, then you can prevent them from appearing by deselecting this option.

Automatically Free Memory

Switches on TweakTrays auto-memory freeing.    For more information on this setting, click here.

Auto free when less than

For more information on this setting, click here.

Attempt to auto free

For more information on this setting, click here.

Display amount of free memory as a tooltip

Normally when you put the mouse cursor over the TweakTray icon in the system tray, it just identifies the 
program as TweakTray.    If you select this option, when you put the mouse cursor over the TweakTray 
icon, it will tell you how much free RAM you currently have.

Display Reboot Options

By selecting this option, all the reboot options will be displayed on the TweakTrays right-click menu.    If 
you never use these options, then you can prevent them from appearing by deselecting this option.    For 
more information on the reboot settings, click here.

Ask for Confirmation before rebooting

For more information on this setting, click here.

User Defined Programs

You can define your own programs to be launched quickly from TweakTray from this settings.    For more 
information on defining your own applications, click here.



Run TweakAll

By selecting this option from the TweakTray menu, TweakAll will be loaded.    This provides a convenient 
and quick way to load TweakAll.



Reboot Options

There are three different reboot options you can use from TweakTray.    'Reboot' exits Windows and 
restarts your PC.    'Restart' restarts Windows, but does not reboot your PC.    Finally, 'Logoff' just logs off 
the current user and returns you to a Windows logon prompt.

If you do not use these options, you can hide them from the TweakTray configuration screen.



Free Memory Options

Free 1/4, 1/2 or 3/4 of memory

Auto Free Memory

Configuring the Auto Free function.



Exiting TweakTray

Selecting the exit option closes TweakTray, and removes the icon from the System Tray.    Exiting 
TweakTray also disables the automatic memory freeing options of TweakTray.



FAQ
This is a copy of the most recent FAQ as of the 15th October, 2000.    A more up to date FAQ can always 
be found on our website at http://www.abtons-shed.com

What is TweakAll?
TweakAll is a free utility that gives you control over your Windows operating system. Using 
TweakAll you make Windows load quicker, and use less memory. 
Set-up Windows the way YOU want it, and not how Microsoft tell you!

I can't believe it's free! Whats going on there?
You may be surprised how many times we get asked this! Lots of people have made great free 
applications available on the internet, and we use many of them so we felt it was about time we 
gave something back.
We make our money through our commercial 'alter-ego' Codeforge, so as long as we keep paying
the bills through other means all Abtons Shed software will be completely free!

What are these plugin things?
To expand the power of TweakAll, we decided to make version 2.0 as expandible as possible. 
The plugins are small extensions to TweakAll that you can easily download and install. Each 
plugin has it's own unique function.
For example, there is a 'Free Memory' plugin that allows you to reclaim wasted memory from the
operating system. When we discover new tweaks, we can just create a new plugin and release it. 
If you don't want particular functions, then simply don't download the plugin!

Where can I download the plugins from?
TweakAll 2.0 plugins can be downloaded in two ways. The easiest way is to simply use the 
'Check for updates' feature within TweakAll (it's on the Help menu). This will automatically 
connect to our server, and inform you of any updates or new plugins. Simply select the ones you 
want and they will be downloaded and installed automatically.
The second way to download plugins is to visit the plugins of our web site and download the 
plugins you want. This method is useful for people who cannot use the automatic method in 
TweakAll for some reason (problems with firewalls etc).

Are you going to add support for...?
If people ask for a feature we will look into it. Please bear in mind that we do not have every 
video card on the market, so adding support for specific video cards may be difficult but we will 
try. If anyone knows of a good place for information for tweaking specific video card etc. then 
please let us know!

Can I create my own plugins?
As long as you know a bit of programming knowledge yes, and even if you don't we will help 
you. TweakAll 2.0 plugins are written using Borland's Delphi programming environment and the 
source code for a blank plugin you can use to make your own is available from our web site at 
www.abtons-shed.com. We are also looking into creating an example plugin using other 
languages.
If you do not know how to, or do not want to, program your own plugin but you have a great 
idea - then just let us know. We will do the programming part for you and give you full credit for 



the new plugin.

In TweakAll 1.x I've managed to lock my self out of the system - Help!
If you are getting a message along the lines of 'Cannot perform this operation due to restrictions 
in effect on the computer' then you have used TweakAll's security settings to restrict access to 
your systems programs. The easiest way to solve this problem is to visit our website and got to 
the TweakAll FAQ page.    On that page you will find a file you can download and some 
instructions to follow that will get rid of the problem for you.

Using TweakAll 1.x my Find option on the Start Menu has disappeared, how do I get it back?
Just follow these instructions:
1. Run Regedit (type "regedit" into the run box from the Start Menu)
2. Open up the tree on the left hand side in this order: 

HKEY_CURRENT_USER
Software
Microsoft
Windows
CurrentVersion
Policies
Explorer

3. Make sure Explorer is highlighted in the left hand side and delete the value 'NoFind' in the 
right hand window.
4. Restart your PC and the find option should be re-enabled. 

What operating systems does TweakAll support?

TweakAll 2.0
The TweakAll program itself will run on any 32bit Windows operating system (Windows 
95/98/98se/ME/NT4/2000). The plugins are designed for specific Windows versions, for 
example, you cannot use the Windows 2000 plugin on any other version of Windows.
When downloading plugins you are told which Windows versions they support, and do not worry
about downloading plugins for an a version of Windows you do not have. TweakAll is smart 
enough to only display the options that you can use.

TweakAll 1+
TweakAll versions 1.0 up to 1.2.3 are designed for Windows 95/98/98se only. If you require 
support for other versions of Windows, then you will need to use TweakAll 2.0.




